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Copyright

This manual and the software described in it are copyrighted © 1996-2000 by PROSONIQ PRODUCTS
SOFTWARE GmbH with all rights reserved. Under copyright laws, this manual and software may not be
duplicated in whole or in part without the written consent of Prosoniq Products.

All trademarks are property of their respective holders.

All features and specifications subject to change without notice.

© 1996-2000 Prosoniq Products Software GmbH
All rights reserved.
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Prosoniq End user License Agreement

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY USING
THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE.
IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, PROMPTLY RETURN THE
UNUSED SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT AND YOUR MONEY
WILL BE REFUNDED.

1. License.
The application, demonstration, system and other software accompanying this License, whether on disk, in
read only memory, or on any other media (the 'Software'), the related documentation and fonts are licensed
to you by Prosoniq and its Licensors. You own the disk on which the Software and fonts are recorded but
Prosoniq and/or Prosoniq' licensors retain title to the Software, related documentation and fonts. This
License allows you to use the Software and fonts on a single computer. You may use a copy of the
software on a home or portable computer, as long as the extra copy is never loaded at the same time the
software is loaded on the primary computer on which you use the Software. You may make one copy of
the Software and fonts in machine-readable form for backup purposes. You must reproduce on such copy
the Prosoniq copyright notice and any other proprietary legends that were on the original copy of the
Software and fonts. You may also transfer all your license rights in the Software and fonts, the backup
copy of the Software and fonts, the related documentation and a copy of this License to another party,
provided the other party reads and agrees to accept the terms and conditions of this License.

2. Restrictions.
The Software contains copyrighted material, trade secrets, and other proprietary material. In order to
protect them, and except as permitted by applicable legislation, you may not decompile, reverse engineer,
disassemble or otherwise reduce the Software to a human-perceivable form. You may not modify, rent,
lease, loan, distribute or create derivative works based upon the Software in whole or in part.

3. Termination.
This License is effective until terminated. You may terminate this License at any time by destroying the
Software, related documentation and fonts and all copies thereof. This License will terminate immediately
without notice from Prosoniq if you fail to comply with any provision of this License. Upon termination
you must destroy the Software, related documentation and fonts and all copies thereof.

4. Limited Warranty on Media.
Prosoniq warrants the compact disc on which the Software and fonts are recorded to be free from defects
in materials and workmanship under normal use for a period of ninety (90) days from the date of
purchase as evidenced by a copy of the receipt. Prosoniq's entire liability and your exclusive remedy will
be replacement of the diskettes and/or compact disc not meeting Prosoniq limited warranty and which is
returned to Prosoniq with a copy of the receipt. Prosoniq will have no responsibility to replace a disk/disc
damaged by accident, abuse or misapplication. ANY IMPLIED WARRANTIES ON THE COMPACT
DISC/DISKETTE(S), INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90)
DAYS FROM THE DATE OF DELIVERY. THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

5. Disclaimer of Warranty on Prosoniq Software.
You expressly acknowledge and agree that use of the Software and fonts is at your sole risk. The
Software, related documentation and fonts are provided 'AS IS' and without warranty of any kind and
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Prosoniq and Prosoniq' Licensor(s) (for the purposes of provisions 4 and 5, Prosoniq and Prosoniq'
Licensor(s) shall be collectively referred to as 'Prosoniq') EXPRESSLY DISCLAIM ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. PROSONIQ DOES NOT WARRANT THAT THE FUNCTIONS
CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT
DEFECTS IN THE SOFTWARE AND THE FONTS WILL BE CORRECTED. FURTHERMORE,
PROSONIQ DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE
USE OR THE RESULTS OF THE USE OF THE SOFTWARE AND FONTS OR RELATED
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR
OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY PROSONIQ
OR A PROSONIQ AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN
ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. WITHOUT LIMITING THE
FOREGOING, PROSONIQ DISCLAIMS ANY AND ALL EXPRESS OR IMPLIED WARRANTIES
OF ANY KIND, AND YOU EXPRESSLY ASSUME ALL LIABILITIES AND RISKS, FOR USE OR
OPERATION OF THE SOFTWARE, INCLUDING WITHOUT LIMITATION.  SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOU (AND NOT PROSONIQ OR A PROSONIQ
AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU.

6. Limitation of Liability.
UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL PROSONIQ BE LIABLE
FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT FROM
THE USE OR INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTATION, EVEN
IF PROSONIQ OR A PROSONIQ AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. In no
event shall Prosoniq' total liability to you for all damages, losses, and causes of action (whether in contract,
tort (including negligence) or otherwise) exceed that portion of the amount paid by you which is fairly
attributable to the Software and fonts.

7. Controlling Law and Severability.
This License shall be governed by and construed in accordance with the laws of the Federal Republic of
Germany.  If for any reason a court of competent jurisdiction finds any provision of this License, or
portion thereof, to be unenforceable, that provision of the License shall be enforced to the maximum extent
permissible so as to effect the intent of the parties, and the remainder of this License shall continue in full
force and effect.

8. Complete Agreement.
This License constitutes the entire agreement between the parties with respect to the use of the Software,
the related documentation and fonts, and supersedes all prior or contemporaneous understandings or
agreements, written or oral, regarding such subject matter. No amendment to or modification of this
License will be binding unless in writing and signed by a duly authorized representative of Prosoniq.

Should you have any questions or comments concerning this license, please do not hesitate to write to
Prosoniq Products Software GmbH, Technologiefabrik Karlsruhe, Haid-u.-Neustr. 7, 76131 Karlsruhe,
Germany. attn: Warranty Information. Email: info@prosoniq.com.
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Preface

Dear sonicWORX User,

First of all we would like to welcome you to sonicWORX 2, the new version of our high-end music
processing software for Apple Macintosh computers based upon Prosoniq's outstanding Neural Network
audio processing technology.

Prosoniq Products is a German software company researching and developing new techniques for audio
editing and digital signal processing. During the last decade we have developed new methods and
algorithms that allow new and previously unthinkable sound manipulations giving you enhanced access to
all specific features of a particular audio recording on your Apple Macintosh computer.

Being available on the Mac since 1996, sonicWORX is today being used throughout the world by top
rank producers and studios and has been featured in many well known commercials, film and music
productions.

Further developments from PROSONIQ and affiliated third party providers will greatly enhance the
possibilities of your copy of sonicWORX.  We therefore urge you to become a registered sonicWORX
user and send in your personal registration card included with this software package today.

Prosoniq is committed to saving the environment. Therefore we have decided to not enclose a printed copy
of this manual in the sonicWORX package. This helps both saving trees and keeps the environmental
pollution low. Should you nonetheless wish to have a printed copy of this book, you can order it from our
online shop at http://www.plugin-shop.com when it is available in printed form.

We sincerely hope you will enjoy the new ways that sonicWORX offers to you. If you have any
suggestions or comments please do not hesitate to contact us via fax or e-mail. Our contact details are
listed on the last page of this manual.

The Prosoniq Products Software Team
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Chapter 1 - Installation

1.1 Setting up the audio system

sonicWORX 2 supports audio devices through Steinberg's Audio Streaming Input/Output (ASIO) driver
model. This means that you can use hardware in conjunction with sonicWORX when there is an ASIO
driver for this hardware. When it comes out of the box, sonicWORX only supports the Apple
SoundManager through the SoundManager ASIO driver. If you wish to use other hardware on your
system, check with the vendor of that hardware for the availability of an ASIO driver.

Please see the instructions in the manual that came with your card on how to connect it with a mixing
console for recording and playback.

Where do I put the ASIO drivers?
ASIO drivers need to be in the „ASIO drivers“ folder that is located in the same directory as the
sonicWORX application. If you add more ASIO drivers to that folder make sure you quit and restart
sonicWORX so they are properly loaded. It is recommended to only install the ASIO drivers for the card
that you plan to use with sonicWORX. It is also recommended to always leave the Apple SoundManager
ASIO driver in your ASIO drivers folder. Should there be an error loading the ASIO driver for your card,
sonicWORX can always default to playback through the built-in Apple hardware.

How do I select the hardware for recording and playback?

• Open up the "Audio Setup..." dialog in sonicWORX' file menu.
• Select the device you wish to use for playback and recording
• Click "Apply" to change the device.

For troubleshooting the audio system please see the chapter "Troubleshooting" later in this manual.
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Quickstart - Processing a file

1. Open an Audio file by choosing "Open" from the "File" menu or use the mouse to drag the audio file
onto the sonicWORX icon. A waveform window opens and shows you the contents of the file.

2. Select the DSP algorithm you want to try out by choosing it from the "Offline" menu. It appears in the
list of algorithms located on the left side of the parameter window.  Let's suppose you have chosen
"Pitch Transpose" from the "Utility Algorithms" submenu.

3. The individual parameters of the algorithm are now available in the right side of the parameter window.
Use the mouse to adjust the parameter settings to meet your requirements. Please note that the standard
parameter values automatically set on activating the new algorithm can be used in most cases without
adjustment.

4. If you want to try out different parameter settings adjust the controls using the mouse.

5. Activate the waveform display window by clicking on its title bar or in an area not used by any controls.

6. Define the area of the audio recording to be processed by selecting a part of the sample (click into the
waveform display and, while still holding down the mouse button, move the mouse to select the area
you are interested in). The selection is now indicated by a different background colour.

Note: you may use the key shortcut "Command-A" to select the whole sample.

7. The Process button in the waveform window shows the name of the process that you have selected. In
our example it has the name "Pitch Transpose". Click this button to start processing. The current state
of processing is indicated by the percent value within the "Process Offline" button. The processed
material is automatically selected (you can see the selection move through your sample as processing
continues) and can be immediately played back. You can listen to the result at any time by hitting the
space bar or pressing "Command-P" (processed version) or "Command-L" (last, unprocessed version).
If you do not like the result you can abort processing by pressing "Command-Period".
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Quickstart - Using VST plug ins

To use VST PlugIns in sonicWORX, make sure you copy them to the "sonicWORX Studio PlugIn"
(Studio version) or "sonicWORX Bundle PlugIns" (PowerBundle version) folder. You can also place
your "Vstplugins" folder that contains your VST plug ins (or an alias of it) in the same directory as
sonicWORX.

Please note that sonicWORX Artist does not support VST PlugIns.

Please note: If you arrange your VST PlugIns in subfolders, sonicWORX will create hierarchical menus
in the Realtime menu. This makes it easier to keep track of all VST PlugIns when you have many different
modules. You could, for example, create subfolders in the sonicWORX PlugIn folder that sort the PlugIns
by purpose, such as mastering, sound design, special effects asf.

1. Open an Audio file by choosing "Open" from the "File" menu or use the mouse to drag the audio file
onto the sonicWORX icon. A waveform window opens and shows you the contents of the file.

2. In the "Realtime" menu, select "Add Module" and choose the VST PlugIn you wish to apply. The
sonicWORX Realtime page opens and the plug-in is added to the list of plug-ins. When you now start
playback you will hear the result of the processing in real time. Use the "Open" button in the Realtime
page to bring up the plug-in editor window an adjust all parameters until satisfied.

Hint: If you want to make your changes permanent, select the portion of the file you wish to process with
the VST plug-in (or hit Command-A to select the whole file) and hit the "Process File" button at the top of
the Realtime page.

Hint: If you have added multiple VST plug-ins, you can change their order by dragging them as desired.
To do this, grab the plug-in entry by its title bar and move it down or up to the position you want it to
have.

Please note: All realtime processing is done starting from top to bottom.
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Chapter 2 - sonicWORX User Interface Overview

2.1 Introduction to sonicWORX editor

sonicWORX accepts audio files of the formats 'AIFF', 'AIFF-C' (uncompressed only) as well as
SoundDesigner II, WAVE and unformatted Raw files. It reads mono and stereo files with a word length
between 8 and 32 bit and with any sampling rate. It can also import several other audio file formats, such
as the ENSONIQ PARIS PAF and System 7 sound files.

The sample editor and all DSP functions of sonicWORX are completely disk-based; the samples don't
therefore need to fit into memory (RAM) and may be as long as you want. All changes to the source
material are written to separate files allowing unlimited undo (within the capacity of your harddisk, of
course) if the result of the processing isn't satisfactory. Please note that sonicWORX nevertheless requires
approx. 32 MBytes of free RAM to function properly. This is because the plug-in modules need a huge
amount of RAM (in the worst case up to 10 MByte each) to store intermediate results and/or pieces of
audio.

sonicWORX is split up into two main components; the main program which contains all sound editing
features such as copying, cutting, displaying as well as all playback, record and file format conversion
capabilities, and the sonicWORX plug-in modules (contained in the "sonicWORX Plug-Ins" folder)
which carry the actual processing power of sonicWORX. This structure allows for easy updating and
configuring of the DSP functions of the program.

There are several types of documents available in sonicWORX:

• the wave editor window shows you an amplitude/time diagram of the audio material and lets you select
portions of the file. You may also start the execution of any DSP function.

• the parameter edit window displays the parameter set (all sliders and buttons of a particular algorithm)
for the plug-in that is currently selected. You may also select a parameter set from a list of sets to modify
or apply it to a piece of audio.

• the realtime DSP main page window provides all interfacing for sonicWORX native and VST plug-
ins.

• the realtime analysis display windows that can be opened from the "Realtime" menu display the
audio output in a processed form, you can e.g. open the Analyzer window to see a Frequency/Amplitude
diagram of the audio data currently played back or being fed into the audio input of your Macintosh (see
the description of the Realtime menu below).
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Chapter 3 - sonicWORX Window Types

sonicWORX offers a powerful and highly intuitive user interface. It has different window types that are
used to display and manipulate different aspects of your recording. Please find an in-depth discussion of
these windows and their function below.

3.1 Overview

The sonicWORX user interface consists of the following main areas

• the "Process Offline" button
• the waveform overview
• the snapshot buttons
• the waveform display
• the transport bar

A detailed explanation of these window types follows below.
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3.2.1 The "Process Offline" Button

The actual processing is started by selecting the portion of your file you wish to process and using the
"Process Offline"-Button in the middle of the wave editor window. The actual naming of the button
reflects the algorithm chosen from the "Offline" menu so you always see which process will be applied
when you hit that button. During processing, the percentage of the material already processed is shown as
a percent value in the middle of the button. If the button is not visible - because another window is
covering it - the percent value will be displayed in the title bar of the wave editor window.

Parallel Processing:
If enough RAM is available, you can also process different files with different algorithms or different
settings of the same algorithm at the same time. Simply start processing in the second file as you would
do with a single file while the first is still processing.

Preview/Instant Audition:
Please note that unlike other programs sonicWORX does not block playback when you process a file.
Thus you can always audition the portion of the file that has been processed so far, giving you a "preview"
capability. You can abort the processing at any time by hitting Command-Period or by clicking on the
"Process Offline" button again.

One-Step Undo+Process:
Holding down the Option (Alt) key on the keyboard when clicking on the "Process Offline" button
undoes the last operation and restarts processing („Undo+Process“ Shortcut). This way you can
manipulate the parameters while you are processing, and when you wish to check out a new setting and
abandon what you have processed so far just use the Option-Click feature to undo and restart processing.

Please note: the file auditioned via the playback function is always the file shown in the frontmost
window. If a parameter or realtime window is at front, playback of the frontmost wave file can be started
by hitting the space bar.

Please note: You may also hit the "Return" key on the keyboard to start offline DSP processing.
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3.1.2 The Overview

The Overview is the small waveform display just below the Transport Bar. It always shows the complete
audio recording and serves for global orientation and navigation within the audio material. It is especially
useful for long audio recordings and for zooming in and out. The overview display is always built in the
background so you have no extra waiting time until the calculation of the overview display is finished. It is
also stored with the file and therefore allows for a fast "Open" option.

The red outline in the overview display shows you the position and size of the segment shown in the wave
editor.

A single click into the overview display moves the red outline to the new position leaving the length of the
displayed segment (the zoom factor) unchanged. The wave editor display below the Overview then shows
the new segment.

By clicking and dragging the red outline with the mouse you can define a new position and size (zoom
factor) for the wave editor display.

-(direct playback)-Function
By holding down the "Control" key and clicking into the overview display you can start playback from the
position of your mouse. You will also see the mouse change its shape when holding down the Control key
with the mouse located in the overview display.

Note: If the window is located in the background it will not be made frontmost if you click into it while
holding down the Control key.

Hint: Clicking in the ruler above the overview (where the time index of the audio file is displayed) will
start playback from that position.
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3.1.3 The Snapshot buttons
(Studio and PowerBundle only)

The snapshot buttons serve for instant saving and recalling the version of the file you are currently editing.
If you decide to keep an editing step but want to continue processing the file or undo your changes the
snapshot buttons allow you to keep a state of a file regardless of what you are subsequently doing. You
have two snapshot slots for a maximum of two snapshots. If you want to handle more than two edited
versions you should use the History Window which shows a graphical representation of all editing and
DSP steps.

If you are opening a file for the first time or if you didn't use the snapshot buttons in the current edit
context they will be empty:

  Empty snapshot buttons - no snapshots stored.

Now let's suppose you've just made an editing step and want to keep this step for a later decision of what
sounds better. To do this, simply click one of the two snapshot buttons to store a snapshot.

  Snapshot stored in snapshot slot #1

The snapshot slot #1 is now blank indicating that the current edit version is stored. If you go on editing,
the snapshot button will change into

  Snapshot stored in slot #1 - ready for recalling

indicating that the version of the file currently displayed in the wave editor window is not the same as the
version stored in the snapshot. If you click the snapshot button, the version you have just stored will be
recalled replacing the current edit step.

If you hold down the "Control" key while clicking on a snapshot button you can listen to the stored
version at any time. You will always hear the area that is selected in the waveform window giving you the
possibility to compare a certain region of an audio recording.

To store a new snapshot and overwrite an existing one, hold down the Option key while clicking the
snapshot button.

  to store a new snapshot hold down the option key while clicking the snapshot button

The word "Store" is shown in red if the mouse is inside the box showing that you are about to overwrite
an existing snapshot. Click once to store the new snapshot.
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3.1.4 The Waveform Display

The waveform display shows the exact time-amplitude representation of your audio data. Here you can
perform simple edit operations like Cut, Copy and Paste and locate short limited events in time like clicks.

The cursor
Within the waveform display a cursor (a flashing vertical line) exists presuming that no area is currently
selected (shown on a different color). The cursor defines the position where cutted/copied material will be
inserted by a paste operation. If no selection was made, playback also starts from the cursor. Like in the
majority of text editing programs, the cursor only exists if no selection is active. An active selection can be
distinguished from other regions by its different background color. You can set the cursor (and disable the
selection) by clicking once into the wave editor display.

Making a selection
If you click into the wave editor display and move the mouse while holding down the mouse button, the
segment becomes selected and is now highlighted by a different background color (which you can adjust
by changing the selection color from the "Color" Control Panel in the Preferences menu). If you move
outside the wave editor window, the waveform display is automatically scrolled at a speed depending on
the distance between the mouse and the window margin.

All playback is now limited to the selected area.

Choosing "Zoom selection" from the "Display" menu zooms the selected segment to match the size of the
current wave editor display.

You can move only the beginning or the end of the selection leaving everything other as is by holding
down "Shift" and clicking into the area near the selection boundary.

Hint: Clicking in the ruler above the waveform display (where the time index of the audio file is
displayed) will start playback from that position.

Hint: You can scroll the waveform display manually by clicking and holding the mouse slighly above the
waveform display, where the blue background color is. The mouse cursor will change its shape to an open
hand and you can drag the waveform so you see the portion you are interested in.
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Markers
(Studio and PowerBundle only

Markers are a convenient way to store selections in an audio file. You can also define a type of marker
called a "track" marker to make exporting segments of a file easier. You will find an in-depth discussion
on markers in the description of the markers menu later in this manual.

sonicWORX 1.5 users note: The definition of "marker" has changed between v1.xx and 2.xx of the
program. In sonicWORX 1.xx, markers were used to set input and output ranges for the offline DSP
algorithms. Pop-Up menus were used for the routing. Due to your feedback and since we also believe that
this was not a good way to work with audio files, we have changed the way markers work in sonicWORX.
As of version 2, markers have no conjunction with processing. All processing refers to what you have
selected, and markers are a means for storing cut and loop points, and track start and end positions.

Here are some general rules for working with markers:
Double clicking into the area between two neighbouring markers selects all samples between them. In this
way you can easily audition your decision of what to process.

Double clicking into the area between two neighbouring markers and holding down the mouse button after
the second click while moving the mouse to another channel selects the same segment in the second
channel.

Moving markers
You can manually move a marker by clicking into the flag, holding down the mouse button and moving the
mouse into the waveform display. As long as the mouse is inside the waveform display, the marker can be
moved to its new position. If you release the mouse button with the mouse inside the waveform display the
marker is moved to its new position. If you release the mouse button with the mouse outside the waveform
display the position of the marker is not changed - giving you the chance to "undo" the change to the
marker position if you change your mind.  

Moving markers to a given time index
If you double click the flag of a marker, you can enter the absolute playback time where the marker should
be moved to. If you hit "OK", the marker position is changed to the time index you have just entered. If
you hit "Cancel" the position of the marker is left unchanged.
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Zooming using the zoom buttons
There is a number of additional control elements that can be used to manipulate the waveform display:

The horizontal zoom factor can be changed using the small buttons labeled "+" and "-" next to the
window scroll bars. You can change vertical zoom independently by clicking on the small and large
waveform symbols.

There are a number of shortcuts for setting and resetting zoom:

[Option]+[horiz. "+" button]:
maximum zoom for the horizontal (time) axis with the beginning of the selection or the cursor visible

[Option]+[horiz. "-" button]:
reset to the standard zoom factor for the horizontal (time) axis.

[Option]+[vert. "+" or "-" button]:
reset to the standard zoom factor for the vertical (amplitude) axis.

Choosing "Zoom selection" from the "Display" menu zooms the selected segment to match the size of the
current wave editor display. The shortcut key combination for this is "Command-F". If you press
"Command-Option-F" the last "Zoom selection" will be undone and the previous zoom settings will be
restored.

The "Show Location" popup menu

The "Show Location" popup menu at the lower left corner of the wave editor window allows direct
scrolling to either a marker position or the selection start and end.
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If you hold down the option key, the marker currently selected will be set to the cursor position. If an area
is selected, the corresponding markers will be set to the beginning and end of the selection.

Holding down the Control key while using the Goto-Popup menu starts playback from the specified
position.

 -(direct playback)-Function
By holding down the "Control" key and clicking into the waveform display you can start playback from
the position of your mouse. You will also see the mouse change its shape when holding down the Control
key with the mouse located in the waveform display.

Note: If the window is located in the background it will not be made frontmost if you click into it while
holding down the Control key.



PROSONIQ sonicWORX® User's Manual v2.1-E

p.17

3.1.5 The Transport Bar

The transport bar is for easy control over the sonicWORX playback functionality. Note that you can also
start and stop playback on the keyboard.

PLAY:
Plays the highlighted portion of the audio file. You can also use the space bar or the "enter" key on the
keyboard (please see also the "Preferences" Dialog)

STOP:
Stops all playback.

FF:
Fast Forward. Moves through the file at higher speed while playing back. This is great when you are
looking for a specific part of a song and don't know its exact location

REW:
Rewind. Moves backwards through the file at higher speed while playing back. This is great when you are
looking for a specific part of a song and don't know its exact location

 : Toggle Loop Playback:
Loop playback can also be toggled through the slash "/" key on the numeric keypad. When loop playback
is enabled, sonicWORX will play the selected portion of your file as loop.

Hint: If you are matching start and endpoints of a loop over a larger section of your audio file, use
Command-E ("Play End of Selection" in the "Audio" menu) to play back the last few seconds of the
selected range and the loop. This lets you audition the loop points without having to play back the entire
file. The number of seconds before the end of selection that are played is set in the Preferences dialog
described later in this manual.
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3.2 The Parameter Editor Window

A parameter file is a means for storing different sets of parameters belonging to different algorithms from
the "Offline" menu. It provides an easy way to split the settings used for different projects into groups and
makes it easy to keep your parameter sets in order.

The parameter editor window is split into two main regions:

• a list of all sets of parameters within the parameter file (left half of the window)
• an area showing the actual parameter settings for the current algorithm selected in the list of parameter

sets (right half of the window)

A parameter file only holds settings for offline (non-realtime) DSP functions.

Please note that the parameter file stores only parameter settings and not the actual algorithms, making
parameter files consuming only a very small amount of space on your harddisk. If you do not have all
algorithms installed, you will only see the parameter sets for the algorithms you do have.

Note: In order to enable offline processing, a parameter editor window must be opened with an algorithm
selected.

sonicWORX 1.5 users note: in version 2 of sonicWORX, there is no need to open a new parameter
window prior to adding offline DSP algorithms to it. When you select an algorithm from the Offline
menu with no parameter file open a new parameter file will automatically be created.

If you create a new parameter file using the "New parameter file" function from the "File" menu, the
parameter file will be empty until you select an algorithm from the "Offline" menu. If you do so, an entry
will be added to the parameter file and the newly added algorithm will be automatically selected for
modification. The parameters for this algorithm are now shown in the right half of the parameter editor
window. You can select a different entry by clicking on it using the mouse.

Direct Dial:
When you have more than one algorithm loaded in your parameter editor you can jump to the entry by
typing in its first character(s) on the keyboard.

Saving:
You can save the parameter file using the save commands from the "File" menu.

You can delete the current entry in the parameter file by choosing "Delete" from the "Edit" menu or
pressing Backspace on the keyboard.

The "Parameters" popup menu

The popup menu in the lower left corner of each parameter window labeled "Show Parameter" allows
direct scrolling to the different parameters of an algorithm. This is especially useful if you are using a
small monitor and the parameters do not fit into it at once.
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Since this software was ported from a Silicon Graphics Workstation, we decided to keep the feature of
OSF Motif™ windows that allows manipulating the contents of a window without first having to select it
(making it "frontmost"). This "Transparent Edit Mode" is enabled by holding down the Command key.
With the Command key held down you can edit parameter sets or waveform display data in non-active
windows in the background allowing for a very fast working speed when handling a lot of windows.

For a description of realtime DSP processing please see the discussion on the Realtime menu in Chapter
4.6.
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Chapter 4 - sonicWORX Menu Functions

There are several useful functions that are activated through the sonicWORX menu bar at the top of the
screen. Here is an explanation of these functions and what they do.

4.1 The File Menu

This menu contains all functions concerning file management such as Open, Save, and New.
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4.1.1 New audio file...

This function creates a new (empty) audio file. You may insert audio material using the copy and paste
operations described below.

If you select "New audio file..." a dialog box will ask you for the parameters (sample rate, file format,
number of channels) of the new file. If you check the "Define Location" checkbox, you can set the
destination path of the new audio file to be created.

If you hit "OK", an empty audio file will be created.
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4.1.2 New parameter file

This function creates an empty new parameter file. A parameter file is a means of storing the settings of
numerous offline plug-in modules for easy archiving and for keeping order if you are working with
different projects.

You may add new entries by selecting a plug-in from the 'Offline' menu.

This file does not store the actual plug-ins but only their parameter sets. If you do not have all plug-ins
installed and try to use a parameter file that contains parameter entries that need a specific plug-in, they
will not appear in the list.

sonicWORX 1.5 users note: You do not have to create a new parameter file manually. If you select one
of the algorithms from the Offline menu with no parameter file open, a new one will be created.
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4.1.3 Open...

This command can be used to open parameter, realtime parameter and audio files. You will see the
following dialog appear:

The two symbols below the list of available files on your disk define what kind of file will be displayed in
the file list. If the left symbol is selected, you may choose only parameter and realtime parameter files, if
the right one is selected (as is by default), you will see only audio files of the type sonicWORX can work
with.

If you enable the "Open as raw audio file" checkbox, all files in the current folder will be displayed
enabling you to load any file as an audio file. If you enable this option, the dialog box will expand and
show you different parameters you should set according to your knowledge of the file format.
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The expanded Open dialog box lets you adjust all sample parameters manually. You can use it to open any
file as if it would contain valid audio data.

A word of caution: listening to such files can result in high output volumes that may possibly damage your
loudspeakers and auditory system, so be careful.

Besides general file information (e.g. sample type and number of channels) the expanded Open dialog lets
you define an offset to ignore header information at the beginning of the file making it invisible to all Edit
and DSP processes. In addition, Save handles the offset correctly and does not change header information
in any way.

The "Play" button plays the currently selected audio file if it is able to interpret the format of the file.
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4.1.4 Import

Import allows you to load files into sonicWORX that are not directly supported but need to be converted
to a file type sonicWORX can understand. Files that need to be imported are ENSONIQ PARIS PAF,
Split Stereo files, System 7 files and Audio CD Tracks.

Opening the file will convert it into a standard file format that sonicWORX can work with. If 'Split Stereo'
is checked, sonicWORX will ask you to open the left channel, then the right channel. You may join any
two files as long as they have the same sample rate as the first one you have selected as the left channel
and both files are of the same length.

To import tracks from a CD, either open the track by browsing to the Audio CD and selecting one of its
track files. You can also drop single CD files (or the entire CD) on the sonicWORX icon to import all
tracks into sonicWORX. The CD tracks will be stored in a folder "sonicWORX CD Imports" on the
desktop folder of the scratch disk. (see "Preferences" for details on how to set the default scratch disk).

4.1.5 Close / Close All

This function closes the current file. If there are changes that had not been saved, you will be asked if you
want to save or discard them.

Click "Save" to save the audio file, click "Don't save" to close without saving or click "Cancel" to abort.
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Key Shortcuts:
Note that you can also use the Command (Apple) key with the first letter of the button instead of clicking
with the mouse (ie. Cmd-D for "Don't save").

If you hold down the option key while activating the File menu this menu entry changes to "Close All"
meaning that all open files will be closed if you select it.

4.1.6 Save

This command saves the current audio or parameter file. If it is a file that was not saved before you will be
asked for a file name. If you have previously saved the file using the "Save as..." function, "Save" saves
the file automatically under its name and replaces the existing version on disk.

You may enable automatic saving after processing in the "Preferences..." dialog.

Please note: When using the "Save" or "Save as..." menu entry all changes are made permanent. You
cannot use Undo or Redo after a save operation.

4.1.7 Save window settings

This function saves all window settings of the current audio file like position, height and width of the
waveform window, position of makers and the overview. This function is extremely useful if you are
working with very large files and you do not want to re-save any audio data.

Please note: sonicWORX automatically keeps track of all edit steps you apply to a file. If the audio data
have not changed since the last save operation, sonicWORX saves only the window settings (or nothing at
all if nothing has changed) to speed things up. You may therefore rarely or never need to use this menu
function explicitly.

The waveform window of the file you want to save has to be active (frontmost) in order to enable this
menu entry.

4.1.8 Save as...

This function saves audio and parameter files under a different name. Use this if you want to save the file
in a different format or if you want to continue working with a copy of it. The original file is left
untouched. If the name of the file you are trying to save it as already exists, sonicWORX asks you if you
want to replace the existing file.
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If you opened the file with the "Open as raw audio file" option you can now save in the same format
("Raw w/offset ####"). The offset you have specified in the "Open" dialog box will automatically be used
and displayed in the dialog box.

Please note: When using the "Save" or "Save as..." menu entry all changes are made permanent. You
cannot use Undo or Redo after a save operation.

Hint: If you use „Save Selection As...“ or „Save A Copy As...“ you can save the current state of the file
as another file. Since Undo is possible after „Save Selection As...“ and „Save A Copy As...“ but not
after „Save As...“ you can then undo all processing if you are not satisfied or wish to try a different
approach.

If you change the word length of the sample format on save, sonicWORX offers you various
requantization options:

TRUNCATE DOWN
If set, sonicWORX will truncate all audio data to the output word length without any kind of dither.  Not
recommended.

ROUND TO NEAREST
If set, sonicWORX will convert all audio data to the output wordlength using rounding to the nearest
neighbour value. Not recommended.
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RECTANGULAR PDF DITHER
If set, sonicWORX will use a noise source with a rectangular Probability Density Function (PDF) for
requantization. For plain dither, this achieves a good SNR while still reducing quantization artefacts.
Recommended for special applications.

TRIANGULAR PDF DITHER
If set, sonicWORX will use a noise source with a triangular Probability Density Function (PDF) for
requantization. For plain dither, this achieves the best results. Use for flat-spectrum dither applications.

NOISE SHAPING ONLY
If set, sonicWORX does plain noise shaping on the quantization error without adding dither noise. This
makes the requantization error less audible, but will still introduce a correlated signal. It may be
advantageous for special applications.

NOISE SHAPED PHP DITHER
If set, sonicWORX requantizes using Prosoniq High Precision Dither™ (PHP). This is a noise shaped
requantization process suitable for all kinds of applications. This should be used as default.

Please see Appendix A for an in-depth discussion of Dither.

4.1.9 Save as autoload...

Saves the current file in the sonicWORX Autoload folder. This folder is located in the same hierarchy
level as the sonicWORX application. On startup, all files placed in this folder (or aliases) will be
automatically loaded. This is a convenient way to save your work so you can immediately continue when
you start sonicWORX the next time.

Please note that there are other options related to autoload files that are set in the preferences panel.
Autoload is also discussed in Chapter 5.

4.1.10 Revert to saved...

If you select this function, all changes to the audio file you are working with since you have last saved it
will be abandoned. You will return to the saved version of the file. Use this if you have tried several DSP
functions and the result is not satisfactory. Note that all undo versions are also abandoned if you use this
function.

4.1.11 Save a copy as...

Saves a copy of the current file under a different name. The current file remains unchanged. Use this if
you have created an interesting sound you want to keep before processing it any further.

See "Save As..." for a detailed discussion on dither options.
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4.1.12 Save selection as...

Saves the area currently selected in the wave editor window (shown by a different background color). If
no area is selected, this menu entry is disabled (light grey).

You may use this function to save single drum sounds from a drum loop by simply selecting the segment
you are interested in and using this command.

See "Save As..." for a detailed discussion on dither options.

4.1.13 Export a Copy as...

Exports the entire audio file of the frontmost waveform window as either Wave, AIFF; SDII or Ensoniq
PARIS PAF audio file. See „Export Selection As...“ for a detailed description.

4.1.14 Export selection as...

Exports the audio file of the frontmost waveform window as either Wave, AIFF; SDII or Ensoniq PARIS
PAF audio file.

If you are exporting a stereo file, you can export the file as Split Stereo file, ie. with left and right channels
stored in separate files. To do this, enable the 'Split Stereo' checkbox in the lower right corner of the
dialog display. sonicWORX will automatically complete the file name with the appropriate suffixes
depending on the file format and Split Stereo settings. Edit the file name manually if you need different
suffixes.
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4.1.15 Save tracks...

Saves individual tracks from a large audio file. See the „Track Markers“ description and Chapter 5
„Exporting individual CD tracks from a single audio file“ for details on how this works.
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4.1.16 Record to file...

About the Steinberg ASIO Interface
With version 2.0, sonicWORX uses the Steinberg ASIO (Audio Streaming Input/Output) technology for
recording and playback. This is done to use existing technology for making audio in/out more compatible
to new hardware, and to allow for sampling rates that would not be supported by the Apple MacOS
SoundManager. With ASIO, you can record and playback at virtually any sample rate and word length,
provided your hardware can cope with it.

In order to use your audio hardware with sonicWORX, you need the corresponding ASIO driver from the
vendor of your audio hardware. Please see the documentation and CD that came with your audio hardware
for more details or visit the internet home page of the vendor for the latest drivers. The ASIO driver needs
to be placed in the "ASIO Drivers" folder at the same directory level as the sonicWORX application.

Please note that Prosoniq only supplies an ASIO driver for the Apple SoundManager. If you wish to play
and record through additional hardware, you need to obtain an ASIO driver for the hardware you own.
Usually all vendors supply an ASIO driver with their card. Please see the manual and CD that came with
your audio hardware for more details.

"Record" is used to record from the currently selected ASIO device (you can set this with the "Audio
Setup..." menu entry).

If you experience clicks and glitches during playback, try turning virtual memory off before recording or
playing back a file. This is done using the control panel "Memory" found in the control panel folder in
your system folder. You should always have virtual memory turned off when working with sonicWORX
to ensure a problem-free playback and recording process.

If you select "Record to file..." a dialog box appears for setting the format and sample rate of the new file.
Adjust all values until you are satisfied.

If you check the "Define Location" checkbox, you can set the destination path of the new audio file to be
created explicitely.

If you are satisfied, click the "OK" button. A peak-meter is displayed and should show a volume
representation of the input signal.
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If you are recording from an analog input, adjust the volume of the external playback device (the device
you are recording from e.g. a CD or DAT player) until the peak meter never or very rarely reaches the
0dB (rightmost) segment of the meter bar. Now you are ready to begin recording. If you are recording
from a digital input, volume adjustment does not apply to you.

DONE:
"Done" allows exiting without doing anything, or when you're finished recording.

If the recording level wasn't adjusted optimally you may use the plug-in "Normalize Gain" to optimize it
later. However, please notice that you get a higher audio quality by recording at the highest level possible
without clipping.

If you use the built-in audio input of the Macintosh computer, apply the plug-in "DC Correction" after
recording to remove unwanted DC offset that is produced by the Mac audio hardware.

If the input level seems to be extremely low, make sure that the input level of your audio card is set to its
maximum allowed value ("Audio Setup..." menu).

MONITOR:
If you want to monitor your audio signal before and during recording, enable the "Monitor" checkbox.
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RECORD:
If you are ready to record click on "Record". If you are done, click on "Done" to finish recording and
return to the editor. sonicWORX automatically opens a wave editor window with your latest recording so
you can directly see and edit it.

PAUSE:
If there are large portions of silence in the sound you wish to record you may pause recording at any time
by hitting the "Pause" button. Click on "Record" to continue recording.

START OVER:
Discards all recorded data and starts over.

AUTOMATIC RECORDING
You can limit recording to a predefined amount of time by setting the values of "stop at...minutes"
accordingly. If you enable the "Auto Close Dialog" checkbox, recording will stop at the predefined time
limit and a new file will be opened, just as if you had used the "Done" button. If you do not check this
option, the record dialog will remain open after recording has timed out.
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4.1.17 Page setup... / Print...

Both menu entries have no effect in this version of sonicWORX.
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4.1.18 Preferences...

This function opens a dialog box in which you can set parameters global to all of sonicWORX' edit
functions.

Disable Startup Sound
If this checkbox is activated you will not hear the sound intro at startup.

Beep after execute
If this checkbox is activated you will hear an acoustic signal when processing has finished.

Save after execute
If this option is enabled, the processed audio files will be saved to disk after processing has finished. This
is very useful if you let your Mac process large files overnight.

The processed file will be stored under the name it was last saved. An existing version of the file will be
overwritten, but note that you can recall previous versions by selecting "Undo" from the Edit menu.

If the file hadn't been saved under a valid file name, you will be prompted for one when you start
executing an algorithm.

Save window settings automatically
If this option is enabled, changes to the window settings (zoom, markers asf.) will be saved automatically
when you close the file.
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Save "Autoload" documents automatically
If this option is enabled, all files loaded from the Autoload folder on startup will be saved with all changes
that you have done to them when you quit sonicWORX or close the window.

Swap "Enter" and "0" on keypad
You can use the Enter and 0 keys on the numeric keypad to start and stop playback. You can switch this
setting to accomodate your preferred setup.

Play last ## seconds of selection
Defines how many seconds before the end of the selection playback is started when using the "Play End
of Selection" function from the audio menu.

Live window dragging
When enabled, the windows will be redrawn as you move them across the screen. This might be sluggish
on slower Macintosh models, so you can turn it off.

Lazy window activation
If this option is enabled, a click in a window in the background will not make it the frontmost window.
This is convenient if you have stacked your windows and do not wish the screen layout to change when
you switch between windows. Note that you can also temporarily enable this feature if you click in a
window while holding the Command-Key.

You can still drag the window if you click in its title bar.

...except audio windows
If this option is enabled, the previous option will not apply to audio windows. This way you can work with
audio files as usual, but the position of all other windows will not change.

Background colors
You can choose your preferred colors for the different parts according to your taste.

Workfile Folder
Defines the folder on which sonicWORX will store its temporary and newly created files. Make sure that
you choose a partition that has a lot of free disk space. If the currently selected workfile folder is not
available at startup, sonicWORX will issue a warning and use your system partition for its temporary files
instead.
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Make sure you define a new location for its workfile folder, or re-enable the original partition by
mounting it or connecting it to your computer.
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4.1.19 Audio Setup...

This function opens a dialog box in which you can set parameters for the ASIO audio engine.

You can set input and output independently from each other, if your hardware and ASIO driver supports
this.

Please also see  the chapter „Setting up your audio system“ at the beginning of this manual

DEVICE:
The audio device used for recording and playback. Select your hardware or the Apple SoundManager.
For audio hardware that has no ASIO support but comes with an Apple SoundManager driver, select
Apple SoundManager and choose the device from the Sound control panel in your control panels folder.

OPEN CONTROL PANEL
Opens the control panel for the selected ASIO device. Please consult the documentation that came with
your hardware for details on available parameters and their meaning.

SAMPLE RATE, CLOCK SOURCE and INPUT/OUTPUT CH.
Sets the sample rate and sync source for the selected device. Please consult the documentation that came
with your hardware for details on which option to choose in what case. Note that input and output sample
rate can be different.

DISK BLOCK SIZE
Sets the size of the chunks that sonicWORX reads from the disk. Larger values will cause a longer delay
between start of playback and when you can actually hear something, but it will also cause a smoother
playback from devices that have a long read time or are heavily fragmented. Increase this value when the
playback stutters.
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READ-AHEAD TIME
The time by which sonicWORX disk read operation leads the actual playback time. Increase this valiue
when you are experiencing clicks and glitches during playback.

PROCESSING:
Defines the size of the chunks that sonicWORX processes between the input and output of the signal
chain. Smaller values might cause CPU overs for realtime plug ins that process their data in chunks.
Larger values will have a greater I/O latency, ie. your changes to parameters will not be effective
immediately. Also, when using sonicWORX in full-duplex mode, the in-to-out delay will be higher for
higher values. Increase this parameter when you experience CPU overs with some plug ins.

SRC QUALITY:
Defines the quality for the sample rate conversion when the input file and the playback rate are not
identical. This option can also be used for full-duplex sample rate conversion if your hardware and its
ASIO driver supports this. This way you can convert the sample rate of a recording "on the fly" without
needing to commit the changes to a file.

Note that the "good" option consumes more CPU cycles and might affect the number of plug ins you can
use in real time with sonicWORX. If you are using a file that plays back at the same rate as the output
ASIO rate anyway you can disable this option entirely to save CPU time.

If you switch this option off and try to play back a file at a different sample rate, sonicWORX will issue a
warning and will not play back this file.

SRC MODE:
This defines whether sonicWORX should convert the sample rate of the file before feeding it through the
realtime plug in page, or afterwards. This option only has an effect if your files' sample rate is different
from the current ASIO playback rate.

SRC -> PLUGINS: Converts the sample rate of the file and then feeds it through the realtime DSP page.
This uses less CPU power but also reduces the bandwidth of the material before processing.

PLUGINS-> SRC : Processes the file and then feeds it through the sample rate conversion. This uses
more CPU power but uses the full bandwidth of the material.

About the Steinberg ASIO Interface
With version 2.0, sonicWORX uses the Steinberg ASIO (Audio Streaming Input/Output) technology for
recording and playback. This is done to use existing technology for making audio in/out more compatible
to new hardware, and to allow for sampling rates that would not be supported by the Apple MacOS
SoundManager. With ASIO, you can record and playback at virtually any sample rate and word length,
provided your hardware can cope with it.

In order to use your audio hardware with sonicWORX, you need the corresponding ASIO driver from the
vendor of your audio hardware. Please see the documentation and CD that came with your audio hardware
for more details or visit the internet home page of the vendor for the latest drivers. The ASIO driver needs
to be placed in the "ASIO Drivers" folder at the same directory level as the sonicWORX application.
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Please note that Prosoniq only supplies an ASIO driver for the Apple SoundManager. If you wish to play
and record through additional hardware, you need to obtain an ASIO driver for the hardware you own.
Usually all vendors supply an ASIO driver with their card. Please see the manual and CD that came with
your audio hardware for more details.

4.1.20 Quit

With this function you can quit sonicWORX. If files are open which have changed since the last Save
operation sonicWORX will ask if you wish to save them now.

Click on "Save" to save the audio file, click on "Discard" to leave without saving or click "Cancel" to
return to sonicWORX.
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4.2 The Edit Menu

The Edit menu lets you cut, copy and trim your audio data in a very extensive way.

4.2.1 Undo & Redo

sonicWORX is equipped with a very powerful multi level Undo function allowing for a variety of
different versions being stored and compared for finding the best processing quality. Not only offers
sonicWORX unlimited Undo steps (of course, restricted to the available disk space on your harddisk), it
also provides you with an advanced graphical version management tool, called the "History Window"
(Studio and PowerBundle only). The History Window displays all edit and DSP steps in a graphical, tree-
like structure allowing overviewing all versions of an audio file in an instant. This History Window is
activated from the "Display" menu discussed below.

The "Undo" function discards the last edit or processing step. sonicWORX is manipulating audio data in
a completely non-destructive way. That is, you can always undo all edit or DSP steps until you arrive at
the original (unprocessed) version that remains unchanged on disk and from which you started.

Please note that Undo does not apply to the parameter values of the plug-in modules.

Before using Undo, you may audition your edit or processing step using the "Play" (Command-P)
function of sonicWORX. You can also use "Play last version" (Command-L) to compare it to the
previous version to which you will return when using the Undo function.

You may "Redo" all steps between the last processing step and the original version by repeatedly using
the "Redo" menu entry or by repeatedly hitting Command-R.
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4.2.2 Undo Items

This menu lets you exclude different display settings from the Undo/Redo process. This is a very useful
feature if you e.g. want to compare a small segment of an audio file to the same segment before or after
processing. We recommend disabling "Selection" and "Display settings" when comparing files to keep
the selection and the display settings (zoom and scroll position) when undoing and redoing editing steps.

4.2.3 Cut

Cuts the selected segment and stores it on the clipboard. The area behind the segment that is removed will
move forward to maintain continuity.

4.2.4 Copy

Copies the selected segment and stores it on the clipboard. The segment itself is not altered.

4.2.5 Paste

The Paste command inserts the audio data currently in the clipboard at the current cursor position. For
details on cursor positioning refer to Chapter 3.

If you have selected an area when calling Paste the data in this area will be replaced without affecting the
length of the sound file.

If no area is selected, the audio material from the clipboard will become inserted at the current cursor
position moving the material behind it towards the end of the file. The file is lengthened in order to make
room for the new data.

4.2.6 Delete

Deletes the selected segment. The area behind the segment that is removed will move forward to maintain
continuity. You can also use the "Backspace" key.

4.2.7 Trim

Trim removes unneeded audio data before and after the current selection. Use this to adjust the length of
your sound file or remove silence at the beginning oft the file.
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4.2.8 Clear

Replaces the selected area with silence. The length of the material remains unchanged. You may also use
the "Num. X" key on the numeric keypad.

4.2.9 Insert silence...

Lengthens the file by inserting silence at the current cursor porition.

Enter the desired number of frames (samples for all channels) or milliseconds into the dialog box.

Press "OK" to insert silence or "Cancel" to abort.

4.2.10 Duplicate

Duplicates the segment you have currently selected. Use this function to expand a single waveform cycle
into a sample or to duplicate the parts of an audio recording. After duplicating, the old (duplicated) and
new (inserted) area are both selected, making the area 2 times longer with each duplicate operation.

4.2.11 Select all

Selects the entire material of the file for editing or playback.

4.2.12 Select Played

Selects the area that was most recently played back.
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4.2.13 Insert channel

Inserts a channel into your recording. Use this to create stereo files from mono files. The new channel is
filled with silence. Note that sonicWORX does not support files with a number of channels greater than 2.

4.2.14 Delete channel

Deletes the channel you have selected. You can select the channel to be removed by selecting a small
segment of its audio data.

If no selection is made, this menu entry will be disabled (light grey).
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4.2.15 Recall Last

Restores the most recent version of the edited file.

4.2.16 Recall / Save Snapshot 1, 2

Restores (or saves when the option key is held down) a snapshot. For details on snapshots, see the
explanations in Chapter 3.

4.2.17 Clean Up...

Removes all unneeded undo data from your harddisk. Use this during an extensive post-pro session when
your disk space becomes low. Clean up gives you two options for cleaning up your undo data:

CLEAN UP
This is the option that clears all undo data except the original version (the one that always remains
untouched on your disk until you save the changes with the Save command from the file menu), the
version currently displayed in the wave editor and all versions belonging to any snaphot you have saved
during the session (if any). Any other version of the file that can be reached via the Undo function will be
permanently deleted. There is NO Undo for this decision (as there is no sense to an Undo-Undo).

CLEAN UP & CLEAR SNAPSHOTS
This is the option that clears all undo data INCLUDING any snapshots you have made up to this time.
Only the original version (the one that always remains untouched on your disk until you save the changes
with the Save command from the file menu) and the version currently displayed in the wave editor will be
left intact. Any other version of the file that can be reached via the Undo function will be permanently
deleted. There is NO Undo for this decision (as there is no sense to an Undo-Undo).

CANCEL
Does nothing and aborts the Clean up operation.
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4.2.18 Auto Delete

If enabled, this option takes care that the Undo tree (the file holding older versions of your audio file)
occupies as little disk space as possible. It does this by deleting the versions you have just "Undone" if
they are expendable (i.e. if they do not belong to a snapshot). With this option on, any Undo step that you
have just made will be discarded once you do any new edit or DSP processing step. If you have - for
instance - just done a "Clear" operation, aren't satisfied and choose to Undo it, the "cleared" version will
no longer be available when you edit or process your file with any further step. Since this is what you
usually may want we recommend you have this option on unless you want to explicitely keep EVERY
editing and processing step.
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4.3 The Display Menu

The "Display" menu provides functions to control the representation of waveforms by the wave editor.
Here you can zoom in and out and update the overview.

4.3.1 Zoom In

Zooms in (magnifies) the displayed view of the waveform one step. You can also set the zoom factor in
the waveform editor directly (see previous chapter).

4.3.2 Zoom Out

Zooms out (shrinks) the displayed view of the waveform one step. You can also set the zoom factor in the
waveform editor directly (see previous chapter).

Please note that displaying large files may take some time at a high zoom-out value if the file is opened for
the first time with sonicWORX Studio. sonicWORX' intelligent cache scheme will then hold important
display information and the display speed will soon become very high even at high zoom-out values.
Display cache data is saved along with the file and subsequent display operations will be fast even when
closing and re-opening the file.

4.3.3 Zoom Selection

Magnifies or makes the waveform representation smaller so that the whole area currently selected is
shown completely in the window.

Command-F acts like "Zoom selection". With Command-Option-F you get back the previous zoom
factor.

Please note that displaying large files may take some time at a high zoom-out value if the file is opened for
the first time with sonicWORX Studio. sonicWORX' intelligent cache scheme will then hold important
display information and the display speed will soon become very high even at high zoom-out values.
Display cache data is saved along with the file and subsequent display operations will be fast even when
closing an re-opening the file.
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4.3.4 Goto Position

Lets you define an absolute position (time index) to scroll to.

4.3.5 Follow Play/Execute

If enabled, the waveform window will always display the portion of the file that is currently playing back
or being processed. This allows for easy following the playback or processing position and is extremely
useful when trying to locate short events like clicks or drop outs in an audio file.

4.3.6 Auto Refresh

If enabled, sonicWORX automatically updates the overview display after processing has finished. If you
do not want this (e.g. to speed up processing of other files that is currently running), turn this option off.

4.3.7 Show History
(Studio and PowerBundle only

This command opens the sonicWORX Undo history window. The Undo history is a graphical
representation of all editing and DSP processing steps you have done up to this time. It is a powerful tool
for managing different versions of the file and comparing and selecting the results of different processing
steps. You will soon learn to appreciate this option, it lets you easily view, delete, select and audition any
version of the file you have opened and edited during a session thus giving you utmost control over all
versions of the file.
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General
If you are working with different files, the history window always displays the Undo history of the current
(frontmost) audio file. All history window operations refer to this document.

The history window displays all versions of the file that can be restored, starting from the original version
of the file (on top of the structure) up to the version currently being displayed (which has a thick red
outline).

Outlines
Any version of the file is displayed as a box in this window with different color and outlines having
different meanings.

• A thin grey outline is indicating that this version of the file is affected by the Auto-Delete (see above) and
Clean Up mechanism and will be deleted if "Clean up" or an auto delete step is done. Please note: If the
body of the box is showing the message "## bytes deleted", deleting this version will not free up any
disk space.

• A thin black outline is indicating that this version of the file will not be deleted by the "Clean up"
procedure because it is either the original version or one stored in one of the two snapshot slots. If you
want to delete this version, you have to use the Delete button just below the History window title bar.

• A thick red outline is indicating that this is the version you are currently seeing in the wave editor
window. You can jump to any version in the history window by double-clicking the version you want to
see.

Processing types
Every box representing a version of the file is further divided into a title bar showing either the name of
the file if the version is the original version of the file or the name of the edit or DSP processing step that
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has created this version of the file, and a body showing the amount of audio data added to the Undo tree
during that step.

Editing steps are showing as black text specifying the name of the editing function (Cut, Copy, Delete
a.s.f.) on a light grey background while DSP processing steps are shown as black text specifying the
name of the plug in (Normalize Gain, Reverse a.s.f.) on a light yellowish background.

Snapshots
If a version was stored as a snapshot, this is indicated by a thick light grey letter in the body of the box (as
shown by the second to last box in the left branch of the Undo tree in the illustration).

Selecting a version from the undo tree
You may select a version from the undo tree by simply clicking into the corresponding box. The box is
then shown on a different background color (the same used for highlighting the selected audio material in
the wave editor). You may then start playback by clicking the "Play" button below the History window
title bar.

You may also delete the version by clicking the "Delete" button below the History window title bar. If the
body of the box is showing the message "## bytes deleted", deleting this version will not free up any disk
space.

Note: hitting the space bar always plays back the version currently displayed in the wave editor window
(the one with the thick red outline in the History window).

You may also select more than one box by holding down the Shift or Command key. If you click the
"Play" button, all versions currently selected will be played back sequentially.

Playing back a version from the undo tree
To play back a version from the undo tree hold down the Control key while clicking in the box
corresponding to the audio file version you want to hear.

History window control elements
There is a number of control elements (buttons) just below the title bar of the History window.

Play
Plays back the currently selected version(s). If none is selected, the one currently displayed in the wave
editor window is played back.

Goto
Jumps to the selected version and displays it in the wave editor window. This is also achieved by double
clicking any version you want to go to.

Delete
Deletes the currently selected version(s).
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Prepare Cleanup
Selects all versions that can be deleted in order to free up disk space. Versions used by snapshots, the
original and the current version are NOT selected. This gives you an idea of which versions are
expendable and can be removed to free up disk space. You may then freely select and/or de-select versions
you want to include or keep before hitting the "Delete" button.

Other history window elements
There are two more elements below the title bar of the History Window that should be mentioned:

Regained disk space
The number beneath the "Goto"-Button is showing you the amount of disk space that will be gained if
you hit "Delete" at this time.

Zoom buttons
In the lower left corner of the History Window you will find + and - buttons that allow for zooming in
and out the History window contents. Use these if your undo history gets very large.
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4.4 The Marker Menu
(Studio and PowerBundle only

This menu allows you to set and remove markers. Markers are a convenient way to mark a region of
interest in the audio file you are working with. They can mark edit points, tracks start and end positions
and other important regions.

Double clicking in the waveform between two markers will select the range between the two adjacent
marker pairs.

Please see the discussion in Chapter 3 for a detailed explanation of how markers work.

4.4.1 New Marker
Sets a new marker at the desired position.

4.4.2 New Marker at Play Position
Sets a new marker at the current play position.

4.4.3 New Markers at Selection
Sets a two markers, one at the start of the selection and the other one at the end of the current selection.

4.4.4 New Track Marker(s)...
Sets two track markers at the current selection. Track markers can be used in conjunction with the "Export
Tracks" function in the file menu to export tracks marked by track markers. A dialog lets you specify a
track marker name.

The end marker for the track is automatically set at the end of the current selection and named "TRK
END".
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4.4.5 Delete Marker
Lets you delete a specific marker.

4.4.6 Delete All markers...
Deletes all markers from the file.  
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4.5 The Audio Menu

In the audio menu, playback functions are accessed. You may play the current or the last version of your
audio file.

Please note: the function "Record" was realized as a "Record to file..." function and can be found in the
File menu.

Input and output playback/recording hardware is set with the menu "Audio Setup..." in the File menu.

Please see also „Setting up your audio system“ at the beginning of this manual.

4.5.1 Play Selection

Plays the data in the file starting from the cursor position. If a selection is active (the wave data is
highlighted with a different color), sonicWORX only plays the selected area.

You also can start and stop playback with the "space" key.

Synchronous playback of different audio files isn't possible in this version of sonicWORX. When
starting playback, the current playback is stopped.

While processing a file by one of the numerous plug-in modules, you can play the portion that is already
done by hitting "Space". This feature is unique to sonicWORX since with most commercial DSP
software you have to wait until the processing has finished. If you are not satisfied with the processing
you may interrupt it at any time by hitting "Command-Period". Note that on slower machines it can take a
while before processing is stopped.

4.5.2 Play End of Selection

Plays the end of the current selection with a pre-roll defined in the Preferences dialog. See the above
descriptions of the Preferences dialog for details. This is a very useful feature when you wish to preview
the latest results of a DSP process.
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4.5.3 Play from Start

Plays the data in the file from the very start. Use this if you want to audition the complete file regardless
of the current selection.

4.5.4 Play from Marker

Plays the data in the file starting from the marker located nearest to the left of the current cursor
position/selection start.

4.5.5 Loop Selection

Starts playback and repeats the selected area until you stop playback.

4.5.6 Stop playback

Use this or the space key at any time to stop playback.

4.5.7 Play last version

Plays the previous version if you have just started or finished an edit or DSP process. This is something
like a 'soft' Undo giving you the chance to compare the new sound with its older version before deciding
to undo or continuing processing.

If no processing has been carried out (that is, if an "undo" isn't possible) this option is disabled.

You may compare portions of the file with its previous version by selecting the portion you are interested
in (assuming processing is completed) and using "Play selection" and "Play last version".
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4.6 The Realtime Menu
(Studio and PowerBundle only

This menu gives you access to sonicWORX' powerful realtime DSP and analysis functions. These
functions can be used during the normal playback of a file or to process or display the audio source
connected to the live input of your Macintosh (either internal audio in or the input of your additional audio
hardware if you have one installed and there is an ASIO driver available).

To enable sonicWORX realtime DSP and analysis functions you do not need any additional hardware,
however, using it on a fast Power Macintosh (at least 604 processor for using multiple realtime modules at
the same time) is recommended. The number of modules you may use simultaneously is only limited by
the CPU power of your Macintosh and does not require any extra hardware to do the DSP processing.

4.6.1 Realtime DSP Page

Opens an empty window in which you can load either the built-in sonicWORX modules or external VST
compatible plug ins.

The modules must be located in the sonicWORX Plugin folder at the same level as the sonicWORX
application in order for sonicWORX to find them. Note that you can create subfolders to arrange your
plug ins in a manner that is easy to maintain.

Important note on using VST PlugIns with sonicWORX
To use VST PlugIns in sonicWORX, make sure you copy them to the "sonicWORX Studio PlugIns"
(Studio version) or "sonicWORX Bundle PlugIns" (PowerBundle version) folder. You can also place
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your "Vstplugins" folder that contains your VST plug ins (or an alias of it) in the same directory as
sonicWORX.

Please note that sonicWORX Artist does not support VST PlugIns.

All DSP modules that are loaded into this window are chained (the output of the previous module is
routed to the input of the next one). All processing is done from top to bottom.

Please note that the realtime DSP main page modules introduce a delay of several milliseconds when
processing the live input of your Macintosh. This effect is called „lateny“. Latency depends on both your
system version, Audio Setup settings and the PlugIns used. As a result of this, it is not recommended to
mix the original and processed signals externally by a mixing console since this may result in signal
cancellations and artifacts. The sonicWORX DSP chain is intended for passthru DSP processing
purpose only and should not be used as an add-on effect processor!

See Chapter 6 - „Troubleshooting“ if you need help on using VST plug-ins with sonicWORX 2.

The DSP main page function bar
The function bar of the DSP main page window contains the following elements:

Active Switch
Enables or disables all DSP processing. If it is turned on, the activated modules are used for processing
your audio data, if turned off, nothing will be processed.

L/R Clip Indicators/Counter/Reset Button
These two clipping indicators will light up when clipping occurs in the DSP chain or the input signal is
already clipped. Try reducing the volume of the input signal using the gain slider of the modules
described below.

Headroom Display
Displays the digital headroom (the available volume headroom until clipping occurs) of your audio
recording at the end of the DSP chain.

Headroom Reset Button
Resets the headroom display to -∞ dB.



PROSONIQ sonicWORX® User's Manual v2.1-E

p.58

Total CPU Load display
This display shows you the CPU load for all modules. If the CPU load gets too high, the audio playback
might stutter or produce drop outs. Note that you can nonetheless process the file in offline mode by
using the „Process file“ button. Offline processing is not affected by CPU speed in any way.

Process File Button
Commits the effects loaded in the Realtime DSP Page to the frontmost audio file. If only a portion of the
file is selected then this portion will be processed only. If nothing is selected, the entire file will be
processed. This is the same as if you had used „Select All“ before applying the DSP page to the file.

The Realtime Page Storage slots
These buttons let you access the 4 different storage slots for the Realtime DSP page. Each of the slots
may contain any number of modules, with arbitrary parameter settings. This means that you have actually
4 different Realtime DSP pages available that are independent of each other. This is useful for comparing
different routings or the result of different modules. All 4 slots are stored when you save the Realtime
DSP Page using the „Save“ or „Save As...“ command from the file menu.

Delete Module button
The button at the bottom of the DSP main page lets you easily delete the selected module from the page.

About the built-in Realtime DSP modules
For a detailed discussion of the built-in DSP modules that come with sonicWORX please refer to the
„sonicWORX DSP Function Reference“ available separately from http://www.prosoniq.com

Loading sonicWORX 1.xx Realtime DSP files
Although the sonicWORX 2 Realtime Page is completely modular, you can still load „old style“ realtime
DSP files that you have created using the 1.x versions of sonicWORX. To do this, simply open them
using the „Open“ menu command or drop them on the sonicWORX program icon. The „old style“
DSP page will come up with all modules that were available in the 1.xx versions of sonicWORX.

Note: If you have an „old style“ Realtime DSP page open you can still open up the new Realtime DSP
page. Your audio signal is fed through both pages, with the „old style“ Realtime DSP page being the first
process in the chain.



PROSONIQ sonicWORX® User's Manual v2.1-E

p.59

4.6.2 Add Module

Adds a module from the list of available sonicWORX native and VST compatible plug-ins to the Realtime
DSP page. If no Realtime DSP page is currently open, a new one will be created.

Each of the Realtime DSP modules has the following settings:

Module On/Off Switch
Turns the module on and off.

Module CPU Load
Displays the CPU load for the module. The total CPU load is displayed at the top of the Realtime DSP
page.

Over indicator
The Over indicator lights up when there is not enough CPU power left to process this module. Drop-outs
and glitches may occur in the output. Remove or turn off modules until you are again within the limits of
your machines’ CPU power.

Module Input Level Display
Displays the current input level at the input of the module. Use the Input Gain slider to adjust the input
volume so that the Clip indicators do not light up. Please note that due to the floating point processing
used most modules will not produce audible clipping when the volume is too high. However, this might
still cause a degradation in the output as most modules are designed to work only reliably within the limits
of the dynamic range of digital audio.

Input Gain Adjust
Adjusts the input gain applied to the signal. Note that you can also type in this value numerically when
you place the mouse cursor over the text input field and type in the desired value on the numeric
keyboard.

Wet/Dry Balance
Lets you mix between the original signal and the processed signal at the output of the module. Use this
for „add-on“ effects such as reverb or delay.
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Program Number / Program Inc./Dec. buttons
You can change the currently active program loaded into the module by either typing in the program
number or using the Increment (+) and Decrement (-) buttons. The number of programs supported
depends on the plug-in that is loaded. Prosoniq usually supports 64 programs per plug-in.

Copy/Paste Program
Copies and pastes the currently active program to another program slot. Paste is only available when the
clipboard is not empty (ie. „Copy“ has been used before).

OPEN-Button
Opens the plug-ins’ parameter editor. Please consult the manual that came with your VST plug-ins for
details on the available parameters and their effect on the audio signal. The built-in plug-ins are described
in the „sonicWORX DSP Function Reference“ available as separate file.

Program Name Text Field
Displays the name of the currently active program. You can also change the name by typing in a new one.

Load/Save
Loads and saves the currently active program either as an individual program file or as a bank file. Bank
files contain all programs of a module. Note that these files are compatible to FX Bank/Program files
created with Cubase VST.

Program Direct Select
Lets you select one of the available programs directly from a list.

Drag & Drop support for module entries
Load program / bank through drag & drop: You can load an effects program file (either an individual
program or a bank file) directly by dropping it on the list entry that contains the module to which it
belongs.

Changing the order of modules: You can move the modules by grabbing them by their title bar and
moving them to the desired position in the signal chain.
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4.6.3 The Prosoniq Realtime Displays

Unlike other analysis software packages, sonicWORX' displays remain unaffected by CPU load
introduced by the realtime DSP processing, they are not influenced when other windows are brought to
the front or when dialogs appear. They also remain totally unaffected by any other software started while
sonicWORX is running and therefore allow a precise and fluent measurement independent of the state of
your Macintosh.

4.6.4 New Analyzer Window

Opens a window with an analyzer display of the input data played back at the time. An analyzer is a means
of displaying audio data as a frequency/amplitude diagram split into different narrow frequency bands.
The Prosoniq analyzer offers 31 bands between 25 Hz and 20.1 kHz with a 1.25x frequency grid
(corresponding to the musical interval Third) showing the amplitude of the frequency bands at a scale
matched with the perceived sound of the recording. It is intended for aiding the producer's or engineer's
ear during extensive mastering sessions or for finding problematic frequency ranges.

P/H
Sets the peak hold interval.

Ch
Sets the channel used for analysis. Note that if the option L-R is selected, you are viewing a multiband
correlation meter with high levels indicating out-of-phase components in the specific frequency range
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Dcy
Sets the decay speed of the fall-off for the analyzer bands. Faster settings will produce more precisely
timed measurements but will also represent the audio material in a less intuitive way.

Type
Sets the decay type of the fall-off for the analyzer bands. Adjust it according to your personal taste.

F/R
Sets the frame rate used for displaying the analyzer output. A setting of 1/1 is recommended to achieve a
smooth display.

Clip Indicator
The clip indicator lights up when the graphics engine cannot draw everything in time. This can happen
when you have many realtime DSP modules open, are running sonicWORX on a slow machine or when
your computer’s graphics hardware is too slow. It may happen even when you have enough CPU power
left, as the graphics hardware on the Macintosh is independent of the CPU, and thus the display
performance may vary.

4.6.5 New Stereo Correlation Display

Opens a window with a Stereo Correlation display of the input data played back at the time. This is a so-
called Stereo Dotgraph Display (Goniometer) meaning the sample values for the left and right channel are
displayed as the x- and y-coordinates of a single dot in a display window. This is a very useful tool for
examining the stereo correlation (the phase relation between the two stereo channels) when mastering to
maintain mono compatibility.
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Smoothing
Defines the attenuation of high frequency compounds in the correlation display. High frequency
compounds do almost contribute nothing to the overall phase correlation but may mislead the human eye.
"Full" is recommended.

Hold Time
Defines the hold time for the display accumulation buffer. Shorter gives a higher display rate.

Mode
Switches between X/Y and L/R (or S/M Stereo/Mono) display mode.

4.6.6 New Level Meter

Opens a window with a Level Meter display. A level meter displays average signal energy while also
detecting short peaks.

Mode:
Switches between VU and Peak display mode.

Peak Hold
Sets the peak hold interval.

Overs
Sets the overs hold interval.



PROSONIQ sonicWORX® User's Manual v2.1-E

p.64

4.6.7 The Control Room window

Opens up the Control Room window.

The control room window controls the output level at the very end of the signal chain. It is intended for
adjusting the output volume while you’re working with sonicWORX. Unlike the other settings in the
Realtime DSP page, all displays and internal gain values remain unaffected by the settings in the Control
room panel. Also, the settings made in the control room panel are not committed to the file when you
apply the Realtime DSP page using the „Process File“ button.

Important: When you are playing back an audio file and are recording it to an external DAT recorder (or other
device), please close the Control Room panel. Recording to external devices is affected by the settings made in
this window. It is very important that you close the Control Room panel prior to recording to an external device as
otherwise the result might not be what you are expecting. For example, the effects of dither in the Realtime DSP
page might be different when the volume in the Control Room panel is not exactly at 0 dB.

4.6.8 Direct Input

Enable this menu entry to route the live input of your Macintosh directly to the DSP processing/analysis
tools. If you do this while any playback is in progress, sonicWORX will stop playback and establish live
input processing.

4.6.9 Release Drivers When In Background

If this option is on, sonicWORX releases the ASIO hardware when it is not the currently active program.
This enables other software to use the ASIO hardware cooperatively with sonicWORX. Turn this on
when you are working with more than one ASIO compatible application at the same time.
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4.7 The Windows Menu

With the "Windows" menu, you can change location and size of the waveform and parameter windows of
sonicWORX.

4.7.1 Zoom window

Zooms the active (frontmost) window to maximum or returns to its last size. This is the same as if you
had clicked in the zoom box of the window in the upper right hand corner of the window title bar.

4.7.2 Reveal in Finder

Opens the directory of the file currently displayed in the frontmost window and selects this file in the
Finder. Use this to quickly check where a file is located on your hard disk. Also available via Command-
Up Arrow.

4.7.3 Send Window to Back

Puts the frontmost window in the background. Also accessible with the key shortcut „Shift + Tab key“.
This allows you to quickly cycle through the open documents without moving them around.

4.7.4 The Window List

All windows currently open are listed here. Use it when working with many windows or a small computer
monitor to navigate between different windows.

Note: when files are currently processed, the percentage of the processed file is reflected in this menu as
well if the window is not currently visible (ie. hidden by another window).

If a file has been changed since it was saved it will appear with an underline in the Window menu list.
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Chapter 5 - Miscellaneous

There are a number of important notes and new features that are worth mentioning but don’t belong to
any of the other chapters. They are listed and explained in this section.

5.1 CD Import in sonicWORX

Version 2 allows directly importing audio CD tracks either individually or as a whole CD. Make sure you
have a CD ROM drive and all required drivers installed, and make also sure you have the latest version of
QuickTime installed on your computer. The QuickTime runtime components can be downloaded from
Apple at

http://www.apple.com/quicktime/download/

To import CD files in sonicWORX, simply open the Audio CD in the Finder and drop the audio tracks
you wish to import on the sonicWORX program icon. You can also drop the Audio CD icon on the
sonicWORX program icon to import all CD tracks.

You can also import individual CD tracks using the „Import“ menu item in the „File“ menu.

5.2 Exporting individual CD tracks from a single audio file
(Studio and PowerBundle only)

sonicWORX 2 has a special type of marker that allows exporting several tracks from a single file in a
batch-like manner. To do this, do the following:

• Open the file containing your audio data.
• Select the portion you wish to export as the first track.
• Select „New Track Marker(s)“ from the „Marker“ Menu
• Type in a name for this track

• Hit the „ok“ button. sonicWORX will place two markers (start and end of track) in the audio file.
Adjust them until you are satisfied.

• Repeat this step until all tracks are marked
• Choose „Save Tracks“ from the file menu
• Define where the tracks should be saved.
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• choose „Save Here“ to export all tracks as individual files. You can directly use them with any CD
writer software to create a CD with these tracks. See the manual that came with your CD writer for
details.

5.3 The sonicWORX Autoload Feature

sonicWORX 2 supports an autoload feature that automatically loads all files from an autoload folder on
startup. All autoload files need to be located in a folder named „Autoload Folder“.

Disabling Autoload
If you do not want sonicWORX to load the autoload files, hold down the space bar key when you start
sonicWORX.
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5.4 Increasing the speed of sonicWORX on your computer

RAM Disk
You could install a RAM disk on your computer if you have enough free RAM available. Copy the
sonicWORX program folder and all audio files to be processed to the RAM disk. Make sure there is
enough RAM disk space to hold the temporary sound files sonicWORX will create (at least the length of
the selected area in the audio file to edit). To install a RAM disk use the control panel "Memory". Refer to
the user's manual of your computer if you do not know how to install a RAM disk.

Remove unneeded system extensions
Remove all unneeded system extensions and control panels from your system folder or start your
computer while holding down the 'Shift'-key to start without any system extensions. We urge you to
remove 'RAM-Doubler' and 'FileSaver' if you have them installed since they might slow down your
computer, in particular disk access.

Note that you need the QuickTime extensions installed in order to be able to import CD Tracks into
sonicWORX.

Virtual memory
Disable virtual memory. Use the control panel "Memory" to switch virtual memory off. Refer to the user's
manual of your computer if you do not know how to disable virtual memory.

Disk Defragmentation
If you use your hard disk extensively for audio work, it is a good idea to defragment it from time to time.
This puts the fragments belonging to one audio file back in order so disk accesses consume as little time
as possible. There are several commercial disk defragmentation tools available. See your local Mac dealer
for details.

Playback Sample Rate
Disable or reduce the quality of the sample rate conversion. sonicWORX uses a high quality sample rate
conversion algorithm for playing back audio files. This algorithm will, however, consume some CPU
power that will not be available for Realtime DSP modules. If you don’t need sample rate conversion
(when you’re working with files sampled at the input/output devices’ sample rate only), turn it off in the
„Audio Setup...“ dialog. If you can do with a lower quality sample rate conversion, select „FIR-1“ in the
„Audio Setup...“ dialog as an alternative. See the description in Chapter 4 for details.
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5.5 Optimum sampling frequency

The algorithms are optimized for audio material having a sample rate of 44.1 or 48.0 kHz. If you process
a file having a different sample rate you may experience a loss in quality since sonicWORX will use a
general purpose processing scheme. In these case, use the "Sample Rate Conversion" plug-in to convert
the sample rate prior to processing the file.

 5.6 The sonicWORX Online Help

Almost all of sonicWORX menu entries and parameters have an online help text available. Turn on
Balloon Help in the ?-menu of the finder and place the mouse on the slider or display element you are
interested in. You may also display a help text for all of the sonicWORX plug-in parameters for easy
referencing without having to use this manual.

5.7 Offline PlugIn Parameter Colors

If you aren't using a monochrome display, you will notice several different colors for the sliders of the
plug-in parameters. They have the following meaning:

Blue (Easy Parameters)
These parameters usually have a great influence on the output effect produced. We recommend you try
them first when experimenting with a new plug-in.

Red (Expert Parameters)
These parameters are used for 'fine tuning' the desired algorithm. In most cases, you can ignore all red
parameters and use the preset factory values with good results.

Green (Mode Select)
If enabled, these parameters change the operation mode of a DSP function. Mostly used for showing the
effect of an operation (e.g. in the APEM De-Reverberation plug-in you may listen to the signal portion
that is removed instead of the de-reverberated signal depending on the setting of this parameter).
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5.8 Entering numeric parameter values in sonicWORX

sonicWORX’s editor supports entering values numerically in text fields. To type in values numerically,
place the mouse cursor over the text input field. You will see that the text field gets highlited with the
background color. Now type in the desired value on the numeric keyboard and hit „Enter“ to confirm. If
you do not wish the change to be applied, hit the „Esc“ key wile your mouse is still over the text field.

5.9 Using the PANDORA Realtime PlugIn in sonicWORX 2

Prosoniq makes an addition to sonicWORX called the „Pandora Realtime“ plug-in. It is a sonicWORX
native plug-in that allows boosting or cutting the volume of the lead vocal in a mix with minimum impact
on other instruments. This functionality is available as add-on for sonicWORX Studio and PowerBundle.
If you have this software, you need version 1.3 or higher of PANDORA Realtime to use it in
sonicWORX 2. The update is available through Prosoniq or your authorized Prosoniq retailer. Please see
the back of this manual for contact information.
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Chapter 6 - Troubleshooting

6.1 Installation problems

The MacOS system software is increasing in its complexity with every month. Thus, it is almost
impossible for a software company to test their software with all system extensions and combinations that
are possible. Although we have a very hard working team of beta testers, there might be a particular
combination of extensions that may cause problems. In this case, try the following:

1. Start with extensions off. Hold down the Shift key while booting, until you see the message "System
Extensions disabled". Try the installation again and see if it works.

2. Allocate more memory to the installer application. Try giving it at least 40 MB of RAM and see if
that works.

If you still don't succeed installing sonicWORX, see our online FAQ page on the internet or contact our
customer support staff by selecting SUPPORT on our web site at http://www.prosoniq.com.

6.2 VST PlugIn problems

sonicWORX can't find my VST PlugIns:

• Make sure you are using sonicWORX Studio or PowerBundle

• Make sure the VST PlugIn modules are either located inside the sonicWORX plug-in folder or inside
the Vstplugin-folder in the same directory level as sonicWORX

sonicWORX gives me an error when I try to load the Pluggo™ series of VST plug-ins

• The Pluggo™ VST plug-ins need some shared files installed in your system. For some reason the
Pluggo™ installer is placing these files in the preferred application folder and not in the system folder.
Therefore the Pluggo™ VST plug-ins might be unable to load the files, and you will see an error. To
correct this, search for two files named „Max Audio Library for Plugins“ and „MAXplugLib“ on your
hard disk. Put these files in your System Extensions folder inside the System Folder. Quit and restart
sonicWORX to be able to load the Pluggo™ VST plug-ins.

Pluggo™ is a trademark of Cycling74.
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6.3 ASIO and audio hardware related problems

On startup, sonicWORX freezes or quits when it gets to loading the ASIO drivers

• some ASIO drivers might quit or freeze the program when they detect that they are not used in
conjunction with the hardware they have been designed for. There is no way we can circumvent this in
sonicWORX, as it is the driver that issues a "quit" command. Make sure you're using the correct ASIO
driver delivered with your hardware. If in doubt check with the manufacturer of the card for
compatibility. To remedy the situation, do the following:

* remove all ASIO drivers from your "ASIO driver" folder located in the same directory as sonicWORX.
* Copy the "Apple SoundManager" ASIO driver back to your "ASIO drivers" folder.
* Launch sonicWORX and see if it still crashes.
* Put the correct ASIO driver for your card in the "ASIO drivers" folder.
* Quit and restart sonicWORX

I just can’t get sonicWORX to work with my ASIO driver

If you have problems with a particular audio hardware, try the following:

• Place the SoundManager driver that came with the card in the System Extensions folder
• Restart your Mac
• Open up the „Sound“ Control Panel from your control panels folder and select the audio hardware as

default input and output device
• Make sure the „Apple SoundManager“ ASIO driver is located in your ASIO drivers folder in the same

directory as sonicWORX
• Start up sonicWORX and open up the „Audio Setup“ dialog from the File menu
• Select the „Apple SoundManager“ driver as input and output device.

When I start sonicWORX or attempt to play a file, I get an error

• Make sure that when you use your audio hardware in conjunction with the ASIO driver in sonicWORX,
it is not selected in the Sound control panel on your Macintosh at the same time. To check this, open up
the Sound (on some systems this is called "Monitors and Sound") control panel and make sure that only
"internal" is selected in the device list. Selecting the same audio device both in sonicWORX and your
system's Sound control panel might cause sonicWORX or the ASIO driver to think that the device is
already in use, and playback might not be possible.

Make sure you always download the newest version of the software from
http://www.prosoniq.com (DOWNLOAD category) before contacting customer support.



PROSONIQ sonicWORX® User's Manual v2.1-E

p.73

Appendix A - About Dither and Wordlength conversion

What Is Dither and Why Do I Need It?
Dithering is a common technique used when converting audio data from higher to lower wordlength
formats. It has been introduced as a tool for fighting the quantization distortion that will inevitably appear
when truncating a signal of a higher dynamic range down to the conventional wordlength formats used in
music processing and storage. It works by adding a more or less complex random noise to the signal
prior to performing the quantization, thus decorrelating the quantization error from the actual audio
signal, in this way making it sound more 'random'.

Constraints
As can be clearly demonstrated, its application is a necessity and its use highly recommended. However,
most customers' audio equipment will not provide proper playback conditions for the increased dynamic
range and thus the benefits of dither will get lost. Jitter, noisy D/A convertors, EQing and any other form
of processing happening in the customers equipment can affect the achieved increase in dynamics up to
totally undoing the effects of dither.

What is Noise Shaping?
The design of dithering algorithms is driven by the aim to minimize perceived noise against maximally
distributing the first and second order statistics of the quantization error. The overall noise energy the
dither adds to a signal stays the same for all techniques, depending on the number of noise sources used,
but since the ear perceives noise in different frequency bands differently it is desirable to shape the
frequency response of the error signal accordingly to make it least audible (that's why it's called Noise
Shaping). From this, there result a number of different implementations (one of which is the Sony Super
Bit Mapping) that use different filter curves for reducing the noise power spectral density in critical
frequency areas (such as 3kHz and 12kHz), depending on the constraints the system imposes (eg.
realtime processing).

Important things when working with dither
Important facts to be considered when working with dither is that 1) it adds accumulative noise to the
signal when applied more than once, 2) further processing of any kind (even a simple gain change) can
completely undo all benefits of dither without undoing the increment in overall noise that is added during
the process, 3) all processing should be done at the highest available word length, and all intermediate
data should be stored in this format until the final master is to be created.

Rule of thumb
For these reasons, dither should always be the very last DSP process in the chain, and there should not
be any further processing of any kind.
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Appendix B - Artificial Neural Networks

sonicWORX uses a relatively new way to process audio signals and achieve certain effects available to
you as offline and realtime modules. Some of these modules are based on "Artificial Neural network"
processing, a relatively young scientific discipline that tries to model processes encountered in our
nervous system, being the basis of what we call "perception". Please find a more detailed explanation of
this below.

What is a Neural Network

The term "Neural Network" is a descriptive synonym for a data structure derived from simplified models
of "real", that is organic, connected nerve fibres. Biologists as well as computer scientists have learned that
"biological computers", like for example the human brain, have the ability to find and classify even
insignificant patterns in large, unstructured data sets. A human is able to recognize the face of a person
he/she knows in a large crowd of unknown people within a very short time, even though that person may
be viewed under unfavorable conditions, say, with the face half-covered by a hat. The human perception is
also able to recognize a single person's face even if the facial expression may vary significantly, thus
making a simple comparison of images by numerical methods impossible.

The difference between a computer processor (like the one in your Macintosh computer) and a human
brain can also be described in terms of systems architecture: the Macintosh processor is a (albeit very
powerful) single processor that processes many different kinds of mathematical operations within a very
short time, while your brain consists of many zillions of processors, each with a very limited set of
operations and also very limited processing speed, but interwoven in a very, very complex manner not yet
fully understood. This is why a single-processor-system can be a genius in numerical calculations, while a
Neural Network (a set of interconnected processors) makes up for the shortcoming of not being
numerically exact by having the ability to recognize patterns and generalize "rules" out of a set of
examples.

The concept of Neural Networks in practical applications

During the last 30 years or so, computer scientists have developed a growing interest in such Neural
Networks and various computers have been built to study and develop techniques and practical
applications on this basis. Since developing computer hardware and specific Neural Processors is a very
time and money-consuming topic, scientists soon came up with the idea of simulating Neural Networks
completely in software using standard computer systems. The basic idea of employing the technique of
Neural Networks in software is to use a (necessarily very powerful) computer processor to simulate a
complex system of interconnected nerve cells (processors) and to study the behaviour of varying network
structures to external stimuli.

There are a number of practical solutions, most of which can be found in today's computer science
applications: image and speech recognition, optical character recognition, weather forecast, quality
measurement as well as even computer games (chess) and many more. Artificial Neural Networks,
although many million times less powerful than the human brain, can do an extraordinarily good job in
identifying and recognizing consistent patterns in a seemingly chaotic set of data.
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Neural Networks in Digital Signal Processing

No surprise that Neural Networks seem to also be of great use in processing audio signals. Instruments,
such as drums for instance, can be viewed as a consistent, repeating pattern with the same or similar
pattern specifications for each instrument. A Neural Network of an arbitrary structure is able to identify
the position and characteristics of a pattern (instrument) even if it appears in combination with other
instruments playing at the same time. The Neural Network can find similarities between instruments in
different combinations as it can identify the hand writing of a person and translate it into computer
characters (this is called the ability of "Generalization"). Although it is not possible to decompose music
completely at the time, we have developed multi-source separation techniques that allow the separate
processing of different elements within a mixdown signal.

On the importance of new analysis techniques

New transformation methods (as e.g. Prosoniq's MCFE Technology) that provide an increased resolution
of sound characteristics are the basis of advanced sound-resolving algorithms that make sonicWORX a
powerful sound processing system. Neural Networks can be used to represent the spectral contents of a
sound in a far more precise and (from the view of the human ear and auditory system) "natural" way than
"pure technical" procedures as e.g. DFT and related non-parametric transforms do.

Summary

There are two main tasks that can be accomplished by a Neural Network in an audio application:

1. Decompose, generalize and reconstruct audio signals and apply parameter changes to the rules derived
before reconstruction. This process can be used to produce new and previously unavailable sound
treatments in a superior quality.

2. Optimize a "conventional" DSP algorithm to optimally process audio signals to the requirements of an
arbitrary task (e.g. optimize the compression scheme of a multi-band compressor to take into account
the masking effect for different frequency bands to the auditory system thus giving an effect that is
optimized to the listener's ear rather than to technical parameters). This application can be used to
realize "conventional" DSP algorithms that are of superior quality due to a great amount of flexibility
and adaptivity to a given signal.

Both of the above-mentioned features of Neural networks are used in sonicWORX giving you access to a
number of advanced signal processing algorithms that let you modify the acoustic properties of your
audio recording.



PROSONIQ sonicWORX® User's Manual v2.1-E

p.76

Appendix C - Support

Contact us

As audio professionals, our highest interest is to listen to your needs. If there is something you would like
us to know, or any improvement to a Prosoniq product you would like to see, do not hesitate to email us
about it. To ensure a prompt reply, use the email addresses listed on our home page

http://www.prosoniq.com.

From there you can also subscribe to our MAILING LIST to discuss your experiences with other
customers, ask questions and even get in touch with our software development team!

You can also send us postal mail.

Prosoniq Products Software GmbH
Customer Support
Blumenstr. 23
76133 Karlsruhe • Germany


